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Quick Start

RhinoCAM"®
CAM Module 2026

Prefer Printed Documentation? Check Here!

What's New | Quick Start Play List

Quick Start Guides for each RhinoCAM module are available in both PDF and Video format. Refer
to the following information to access these resources:

[T] What's New!
What's New in RhinoCAM 2026

[1] The Complete Quick Start Video Play List

Here is a link to the complete 2026 Video Play List

[T] How to Access the Quick Start Guide Documents

To help you quickly get started in working with each module, select one of the Help
buttons located on the RhinoCAM Learning Resources dialog.

You will find:

e Quick Start Guides

e What's New documents
e Online Help links

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module. To access the Learning Resources dialog:

1. From the Rhino Main Menu, drop down the Main menu and select Learn ...
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To access the Learning Resources dilog in RhinoCAM

2. Select a document from the Learning Resources dialog to get started using the
module of your choice.

¥ You can also select the Open Quick Start Files Folder button located at the bottom
of the dialog to open the Quick Start folder where the source files (start and
completed versions) are located.
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- ~

| Learning Resources >

Welcome to RhinoCAM 2025!

To getstarted as guickly as possible use the following resources.

MILL TURN :
2 e U e uw
What's Mew? Web Resources On-Line Help Quick Start On-Line Help Quick Start
Profile-MEST ———— G-Code
@ U O u ‘
On-Line Help Quick Start On-Line Help Quick Start
MEST ART
@ U e LU
On-Line Help Quick Start On-Line Help Quick Start

Where to go for more help:
To getyourspecific support questions answered click here to fill out a support form.

Forall otherinformation visit ourweb-site www.mecsoftcom

Open Quick Start Files Folder |

Learning Resources Dialog
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Resource Guide

Download this PDF Guide for a list of the available RhinoCAM Resources.

[T] 2026 RhinoCAM Resource Guide

-_3\% The 2026 RhinoCAM Resource Guide!
RhinoCAM

. 18 Pages
Resource Guide |

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Prefer Printed Documentation? Check Here!

What's New | Quick Start Play List
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About this Guide

3.1

3.2

RhinoCAMis a plug-in that is completely integrated within Rhino. To become familiar with the
MILL module we will assume that you have previously completed one or more of these guides. If
you have not, please do so before reviewing this workbook.

This guide will show you how to create tools and setup your first tool library in the RhinoCAM MILL
module. Itis recommended that you do not attempt the Advanced Topics section of the guide
until you are familiar working with tools and tool libraries in the RhinoCAM MILL module.

About the MILL Module

The MILL module offers fast gouge free solids/surface model machining technology coupled with
cutting simulation/verification capabilities running inside Rhino for programming CNC Mills. This
integration allows for seamless generation of toolpath and cut material simulation/verification
within Rhino, for programming milling machines that support 3, 4 and 5 axis continuous
machining.

The module also comes with numerous post-processors to output the programmed G-code to
some of the most popular machines on the market. A simple and well thought out user interface
makes this system one of the most intuitive and easy to use milling systems available today.

You can work with the native Rhino data as well as use any of the data types that can be imported
into Rhino such as solids, surfaces and meshes. Then you can use the RhinoCAM MILL module with
its wide selection of tools and toolpath strategies to create machining operations and associated
toolpaths for CNC Mills. These toolpaths can then be simulated and verified, and finally post-
processed to the controller of your choice.

About the TURN Module

The RhinoCAM-TURN Module is a unique turning product that is used for offline programming of 2
Axis CNC Lathes. This product is a module of RhinoCAM, which is completely integrated inside of
Rhino. This integration allows for the seamless generation of toolpaths and cut material
simulation/verifications inside of Rhino for programming turning machines. Rhino refers to both
Rhinoceros 6 or Rhino 7.

The RhinoCAM-TURN module also comes with numerous post-processors to output the
programmed G-code to some of the most popular CNC machine controllers on the market today.
Additionally, the RhinoCAM-TURN module also includes a post-processor generator that has the
capability to configure entirely new post-processors. These features make programming CNC
Turning easy and affordable.

The RhinoCAM-TURN module supports turning and hole making operations such as Turn Roughing,
Turn Finishing, Groove Roughing, Groove Finishing, Threading, Parting and Hole making
operations such as Drilling, Tapping, Boring, Reverse Boring and Threading.
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3.3

Using this Guide

The Tool Library Workbook will help you create your first Tool Library in RhinoCAM MILL. If you
have existing tool inventory in your shop, the Tool Worksheets located in the Reference section
of this guide can be printed out and used to record the information and dimensions that
RhinoCAM MILL uses to define tools. The Advanced Topics section is full of useful tips and
procedures that you can use to get the most from your RhinoCAM MILL software.

Here is a short list of things you can do with this guide:

1.

2
3
4.
5

How to create Tools in RhinoCAM MILL.

How to create, save and load a Tool Library.

Help you gather information about your existing tool inventory and add them to a library.
How to use the Feeds & Speeds Calculator.

How to perform other Advanced tool related tasks in RhinoCAM MILL.

© 2026 MecSoft Corporation



Getting Ready 11

Getting Ready

41  After Installing RhinoCAM MILL

After you install the RhinoCAM module, determine if you have existing tools for your CNC
machine to work with. If so, go to the Reference section of this guide and print out the Tool
Worksheets. Use them to gather the correct information that RhinoCAM will need to add them to
it's Tool Library. See Add your Existing Tools to a Library for more information.

4.2 Locate the Tools Tab

Afterinstalling RhinoCAM you can locate the Tools tab by referring to the image below. Itis
located below the Machining Browser and at the top of the Machining Objects Browser.

e Afterinstalling RhinoCAM load the MILL or TURN modules and locate the Tools tab shown
below.

f; Tools GF‘.Egmnz g Features [ K-Bases
N
L

t:eata Edit Tools |

i
|

o --_“ b o . y e L X o . P

4.3 The Create/Select Tools Dialog

To display the Create/Edit Tools dialog:
1. Selectthe Tools tab under Machining Objects Browser

2. Selectthe Create/Edit Tools. icon.

]'.g Tools Gﬂegiuns I‘__JFeatures Fo K-Bazes

TG &S Y ey
l[ﬁ?re-rat&-"lEdit Tools |

WW

3. The Create/Edit Tools dialog will display.
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Creste/Select Tool

Toels n Sesvion

Shank
Diameter

B EBVHEERLLVOHBYVTNN

JERX)

—
Tool Diarnater

Hame IBaI-II1

Dialog Box: Create/Select Tools

Properties Feeds & Speeds

Mateiial | CARBIDE v
Cul Materisd Cokr [ ] = |
Murber of Futes |2 :
Tool Murber E 2
Adpst Register |3 =
Cutcom Fegister |9 =
Auial Difzat [i z
Coolant | None -
Conmernts

Save Edits 1o Tool Dielete Tool

Ext | Help
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Creating Tools

51 Create a Tool

You can create a tool anytime before or during the creation of a toolpath operation. Here is the
basic procedure:

1. Select the Create/Edit Tools button from the Tools tab of the Machining Objects Browser
or from the Tools tab of the toolpath operation you are in the middle of creating.

J'.g Tooks GREQiDHS g Features E K-Bases
T, o & e 7 lep Y

bl «_
[ Create/Edit Toals l

WW

or
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2 1/2 Aais Pocketing *
Cut Paamsters  Cut Levsls  Pockstng Erang/Exat Advanced Cut Paamster:  Solng
Contial Geomelry Tool Feeds L Speeds Clemance Flane

m T B Tool Geometry
Drameter
. OF f'l'!_"...-
I'p Angle
B Tool Pr
Teol Hame
tcom Registe
Adjust BrEtEf
Ii,'a‘\.r al
Loolant
C ErmrEnt
B Feeds & Speeds
sparidle &
#d FLa
.* EdU/Cieate/Select Tool '
Prerviews Tool
Gararate Cancsl Save Help

2. This will display the Create/Edit Tools dialog shown below. Notice that you can enter
expressions in the parameter fields. See Tool Related Preferences to see how to
enable/disable expressions in dialogs.
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Creste/Select Tool [ |
4 E 1 i 4 [ A =
B BB VHYEERLILVO22ZBTNNRPEPYS
Tacls i Seszion I | ! | I Properties  Feeds & Speeds
forre e Material CARBIDE ~
T cu MateialCoior ] | =
EEabmaaeamma: Pl Muber of Flges |2 Z
Shank 1 | 1 1 | h .
Diameter HHHHHHHHH Poofb ol Tool Humber £l -
Tool RS Fob ol aduReginer |9 =
Shoulder Cupcom Register |3 =
Larons Aial Offzet 0 :
Flute - =
Length Coolard Mo ~
A l Comenerds
Tool Diarneter
Name [BalMi .
ShankDia Todllen  Shoulderlen |
o5 =] [4 =l [z5 [2
Fhislen  ToolDia
25 = |05
Heldet Helder! w| ...
Save az New Tool Save Editz o Tool Drelete Tool
< > Ext Help

Dialog Box: Create/Select Tools

3. Select one of the Tool Type icons from the top of the dialog.

4.

Create/Select Tool -7
8880V 4.
_ in

In the Name field enter a name for the Tool. A default name is provided but you should
consider giving more descriptive names for your tools.

Enter the physical dimensions of the tool you would like to create. Default dimensions
are provided. As you change the dimensions, the Preview of the Tool will update in the
dialog.

However, it is very important that you enter the accurate dimensions of the actual tool
you plan to use.

Under the Properties tab (on the right of the dialog) select the Material of the Tool and
then enter the tool properties requested for the tool. The Tool Number must be unique
to this tool and the Adjust Register and Cutcom Register are typically assigned the same
value of the Tool Number. The Number of Flutes will affect the Spindle Speed and
computed Cut Feed Rate. We'll get to those in a moment. For a definition of each
parameter you can pick the Help button located at the bottom of the dialog. If you enter
textin the Comments window they will be posted to your g-code file prior to the tool
number being called.
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Properties Feeds 8. Speeds

Material CAREIDE v
Cut Material Color [
Mumber of Flutes .2 —

T ool Mumber 1 =
Adust Register 1 -
Cutcom Fegister |1 >
dial Offget 1] =
Coolant  Mane ~
Comments

7. Now selectthe Feeds & Speeds tab. Here you can manually set the Spindle Parameters
and Feed Rates for this tool. If you do not know what Feed Rate values to use, select the
Load from File button. It displays what we refer to as the Feeds & Speeds Calculator. It
will suggest values based on the Stock Material, Tool Material and other Tool parameters.

© 2026 MecSoft Corporation



Creating Tools 17

Properties  Feeds & Speeds

Spindle Parameters

Speed 14667 = RPM
Direction (@) Cw () COW
Feed Rates [indmin)

Plunage Approach  Engage
23468 2 117342 (88 2

Cut R etract Departure
17342 (8 2 (23468 2

Transfer
(® Use Rapid () Set 23468 ©

Feed Rate Reduction Factors

Plunge between levels (100

First 24" pazs 100

Bottam £ Level oo =
Cut Depth 0 =in

Load from File ...

LHCHHETI
il

3
il

8. When you are done defining your tool's parameters, select the Save as New Tool
button. The new tool is created and added to the Tools in Session list located on the
left side of the dialog. This means that your tool is defined in your current session of
RhinoCAM ONLY. When you save your part file, the tool will be saved along with it.
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Create/ Select Tool
g 88 Vvdgg#HLivvo8
Tooks n Sestion Holder Diametar
Lyl
‘ Holder
Length
Shank
Diameter

Shoulder
Length

Tool Diameter
Mame | Flabill

Holdet [is.  Holdet Len.  Shank Dia
1 & |15 & |05 =

Tool Len

Shoulder Len. Flute Len
4 d2s B[s =
Tool Dia
05 -

€ ¥

—

Y VRS N S e S

9. IMPORTANT: After your tool is listed in the Tools in Session list, if you make ANY
changes to the tool parameters, you must select the Save Edits to Tool button for your

revisions to be saved.

n You can edit the tool properties and click Save Edits to Tool to save the changes.
You can create additional tools by assigning a different name and specify the tool

parameters.

10. When done, pick the OK button to close the Create/Edit Tools dialog.
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rj Tools Gﬂegions ;JFEEtL.IrES HE K-Bases

T O O o Ve Y

n To save Tools to a library, Click Save Tool Library under the Tools tab in the

Machining Objects Browser and specify a folder location and file name in the
Save as dialog box. Saving a Tool library as a Knowledge base file (*.vkb) saves feeds
and speeds with tool properties.

See Create a Tool Library for instructions on how to do this.

5.2 Create a Tool Holder

You can create a Tool Holder anytime before or during the creation of a toolpath operation. Here
are the basic steps.

1. Selectthe Create/Edit Tools button from the Tools tab of the Machining Objects Browser
or from the Tools tab of the toolpath operation you are in the middle of creating.

rg Tools C?F{eginns i; Features % K-Bases
IR0

bl «_
[ Create/Edit Tu:u:uls]

W\WW

or

© 2026 MecSoft Corporation



20 Cutting Tools Workbook - RhinoCAM-MILL

2 1/2 Aais Pocketing *
Cut Paamsters  Cut Levsls  Pockstng Erang/Exat Advanced Cut Paamster:  Solng
Contial Geomelry Tool Feeds L Speeds Clemance Flane

m T B Tool Geometry
Drameter
. OF f'l'!_"...-
I'p Angle
B Tool Pr
Teol Hame
tcom Registe
Adjust BrEtEf
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Loolant
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.* EdU/Cieate/Select Tool '
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2. This will display the Create/Edit Tools dialog shown below. Notice that you can enter
expressions in the parameter fields. See Tool Related Preferences to see how to
enable/disable expressions in dialogs.
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Creste/Select Toel

B BB VHEERLLYO

Toels n Sesvion

_________________________________ Properties Feeds & Speeds
Material CARBIDE ~
Cudt Marerial Coloi -
Numbes of Ftes |2 2
Shank .
Diameter Tool Humber 3 >
Adpt Register |9 =
Shoulder Cupcom Register |3 =
Len
o sl et 0 -
Coolard ' None: ~
Cotenents
| — H
Tool Diameter |
Hame |[BalMin | B L
Shank Dia  Tocllen  Shouderlen |
05 =) |4 &) 125 =
Fhaglen ToodDia W7 E b
25 ) |os =
Hoda [T R e e e fEisnsaisanisin
Save az New Tool Save Editz o Tool Drelete Tool
Ext Help

VN HRRY®

Dialog Box: Create/Select Tools

3. Tocreate or edit your holders, pick the ... button to display the Create/Select Holder
dialog. Holders are save with your tool library.

L dMEter | =
Tool
Length
Shoulder
Length
Flute
Length
@ |
—
Tool Diameter
Name | BalMil |
Shank Dja.  Tool Len. Shoulder Len.
| [x] [x]
05 ¢ 25 L
Flute Len.  Tool Dia
[
s 2
Holder | Holder3 v

Location of the Holders menu

Save as Mew Tool

4. Use the Create/Edit Tool Holder dialog to define your Tool Holders.
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Create/Select Holdes
Hulders in Session -
e T T Mame |Hokder 1: 375" D 425" H
Helder 2 4" D 425" H Holdat Sagmant Pasamsisn:
Holder 3 45" 0 4 75" H Dinmeies Lencth  Taper
Hobder 3 35" D x 4.25'H '3?5 = [os : -u
Add Edit Active
-HnldeiSeg'ner\!:
Segment 4
Segment 3
Segment 2
EEN
< >|F
B HoveUp G MoveDown Save az New Hobder Save Ediz Lo Holder Debete Holdur
€ »| M FRemoved X Remove Active Ext Cancel Help
Dialog Box: Create/Edit Tool Holders
5. Inthe Name field enter a name for the Tool Holder. The name must be unique to the
holder being defined.
6. Tool Holders are created in segments. Each segment has three dimensions. These are:
Diameter, Length and Taper.
7. When you are satisfied with your segment dimensions, select the Add button and the
segment will be added to the Holder Segments list.
8. Toeditasegment, first selectit from the list and then pick the Edit Active button.
9. Select asegment and then use the Move Up and Move Down buttons to arrange the
segments in the proper order that defines the holder being created.
10. A preview of the active Tool Holder is displayed on the right.
11. Use the buttons under the preview window to Save, Edit or Delete the the active Tool
Holder.
12. When your holder is defined, select the Exit button to return to the Create/Select Tool
dialog.
13. To use a Holder, first select a Tool or create one using the Create/Select Tool dialog.
14. Then drop down the Holder menu and select a Holder for that Tool.
5.3 Create a Tool Library

When you create tools they are only saved with the part file you are working on. To reuse tools
efficiently in RhinoCAM, from one job to the next, you should create a Tool Library that contains

all of the tools in your CNC shop's inventory.
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B RhinoCAM automatically installs a Tool Library that you can customize with your
tools. Itisavailable in both English and Metric versions. See the topic Use The
Pre-Installed Tool Library for more information.

The steps below will walk your through creating your own tool library.

1. Complete the stepsin the topic Create a Tool to create to create your first tool. It should
be listed under the Tools tab:

LJ Tools Gﬂegicns , Features TH K-Bases

I i e

2. Fromthe Tools tab menu select the Save Tool Library icon from the menu:
el
3. Fromthe Save As dialog that displays, change the Save as Type selector to *.vkb. Both

formats (*.vkb or *.csv) allow the Feeds & Speeds parameters to be saved along with each
tool definition but the *.vkb format is recommended.

B Select a folder location that is unique to your company or computer and NOT
located within the install path of RhinoCAM. For example this can be a network
drive or even just your Desktop.

4. Now enter aname foryour Tool Library (i.e., My_First_Tool Library.vkb) and pick Save.

5. See the topic Tool Related Preferences to learn how to make your Tool Library load
automatically every time a new part is created in Rhino.
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54

The Feeds & Speeds Calculator

The MILL Module has a built-in Feeds & Speeds Calculator.
That’s right, you can ask the program to suggest feeds & speeds
values based on your current stock material and active tool
parameters! Once a Cut Feed is calculated, you can then choose
to automatically assign feed rate values for the various toolpath
motions in your operation including Plunge, Approach, Engage,
Retract and Departure! The percentages of the Cut Feed to
assign are all controlled from the CAM Preferences dialog.

Of course you can override any of these calculated values at any
time, for any tool and for any operation.

[T] Feeds & Speeds Associated with a Tool

In the MILL Module, feeds & speeds can be defined and associated with a specific tool.
This allows you the flexibility to have different tool definitions based on the type of
material being cut (i.e., steel, wood, acrylic, etc.) or the operation type (Pocketing,
Facing, etc.). The Create/Select Tool dialog includes a Feeds & Speeds tab where these
values are defined. When the tool is saved, the feeds & speeds values are saved with it.

Creste/Select Taol

/a8 vVegygslLavo=eVvinR

Ve

Took i Seszion

Shank
Diameter

f—

Tool Diarneter
Mame [Baidil
Shank Dia Tocllen  ShoulderLen
s =] [ 2l 25 =
Fhtelen  ToolDia
25 |2 [05
Helder | Hodder] | |

Save az New Tool

Dialog Box: Create/Select Tools

[T Feeds & Speeds Associated with an Operation

Properties Feeds & Speeds
Mateiial CARBIDE ~
Cut Msteiial Color | -
Nursbes of Flates |2 =
Tool Murrber 3 >
Adiust Register |9 =
Il CutcomRegier |3 =
| Adal i 0 2
Coolard | Mone b
Connenerts
H
|
i
Save Editt to Tool Delete Tool
Ext Help

Each toolpath operation type also has a Feeds & Speeds tab in its dialog. This allows you
the flexibility to assign feeds & speeds values specific to that operation. The 2% Axis
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Pocketing operation dialog is shown here.

2 1/2 Axis Pocketing X
Cut Pavameters  Cul Lewels  Pocketing Ertiy/Esdt Advanced Cut Paameler:  Soting
Cortrol Geometny Tad Fends & Spesd: Cleaiance Plane

Spnde Parameters
Spead 2446 2 RPM
Driection wow  Ooow ”
Feed Fates t
Punge (F) 23334 |2 jimin -
Approsch () 14667 120 invmin
Engoge ) |11 = n/mn
Cut (1) BT = nimin
Fistiset [R] :1 1 +|  inmin
Depatiee D) [2233 12| jmin

Tearsber [TH (%) Uze Rapid () Set

HIM Z| mmin
Feed Fsle Reduction Fachon
Fhungs between levels .101:! = X
First 3 pass [voo = x
Coolant
MHons -

Load from Tool LLovad froem Filee .

* Gensrale Cancel Save Help

Each Feeds & Speeds tab also contains a button called Load from Tool. This allows you to
load the feeds & speeds values that you have previously associated with active tool. The
Active Tool simply refers to the tool that you have selected from the Tools tab of the
dialog.

As you can see, just between the tool and the operation type, you have a wide range of
flexibility for defining your feeds & speeds strategy.

[T] The Feeds & Speeds Calculator

You may have noticed that both the Feeds & Speeds tab of the Create/Select Tool dialog
and the Feeds & Speeds tab of the operation dialog have a button called Load from File ...
Selecting this button will display the Feeds & Speeds Calculator dialog. This dialog
allows you to load feeds & speeds values that are calculated from information stored in
an external Materials XML file.

[T How does it Work?
There are two parts to the calculator.

Data from Table
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This information is extracted from the default Materials XML table file and is based on
the following parameters:

1. The Stock Material is selected from the Materials dialog located on the Program
tab.

2. The Tool Material is selected from the Properties tab of the Create/Select Tools
dialog.

The values for Surface Speed (measured in units per minute) and Feed per Tooth
(measured in units) are retrieved from the XML file and displayed in the dialog. Units
refers to the part file’s current Units setting.

Input Variables

The values for Tool Diameter and # of Flutes are automatically loaded based on the tool
selected for the operation (i.e., the active tool). Based on these parameters, the
program computes a Spindle Speed value measured in RPM (Rotations per Minute).

Computed Cut Feedrate

A Cut Feed value is also calculated for you (measured in Units/Minute) based on Stock
Material, Tool Material, Tool Diameter, and # of Flutes. Changing the Spindle Speed
updates the Cut Feed and vice versa.

When you pick OK from this dialog, the computed Feeds & Speeds values are submitted
to either the active tool or the active toolpath operation.

Formulas Used for Cut Feed Computation

Spindle Speed

(RPM) Surface Speed (SFM) x 12 / (it x Tool Diameter(in))

Cut Feed (IPM) | Feed Per Tooth(IPT) x # of Flutes x Spindle Speed(RPM)

SFM: Surface Feet Per Minute
IPT: Inches Per Tooth

RPM: Revolutions per Minute
IPM: Inches Per Minute

Units in Millimeters

Spindle Speed
(RPM)

Surface Speed (SMM) * 1000 / (1t x Tool Diameter (mm))

Cut Feed (IPM) | Feed Per Tooth(MMPT) x # of Flutes x Spindle Speed(RPM)
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SMM: Surface Meters Per Minute
MMPT: Millimeters Per Tooth
RPM: Revolutions per Minute
MMPM: Millimeters Per Minute

[T] Let’s Review:

1. You can associate unique feeds & speeds values with each tool or with each
operation.

2. You caninvoke the Feeds & Speeds Calculator from either the Create/Select Tool
dialog or from any toolpath operation dialog.

3. The Feeds & Speeds Calculator extracts data from an external XML file and
combines it with your stock material and tool parameters to calculate suggested
Spindle Speed and Cut Feed values.

4. Changing parameters such as Tool Diameter, Surface Speed, Material, etc. will
calculate new Spindle Speed and Cut Feed values automatically.

5. A percentage of the calculated Cut Feed can be assigned for Plunge, Approach,
Engage, Retract and Departure motions. These percentages are setin the CAM
Preferences Dialog.

6. You canoverride ANY or ALL of the suggested feeds & speeds values at any time!

More information about the Load from File button:

This loads the Feeds & Speeds values from the Feeds & Speeds Table file. This will display the
Load Feeds from Table dialog box to make your selections.

[T] Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to the Feeds &
Speeds tab. The plunge, approach, engage, retract and departure feeds are determined
using a percent of the cut feed. The percent to use for transferring the computed cut
feed can be set under Feeds & Speeds Preferences.
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Feeds/Speeds >
Load Feeds from Table

[rata from T able

Stock Matenal ALUMIMUR - 2024 w

T ool Material CAREIDE w

Surface Speed 1600 : ft. ity
Feed/Taoath 0.004 =

Input Y ariables

Tool Diarmeter: | 0.5 = in
# af Flutes: 2 =

bl awirmurn Limits for Compution

tax Spindle Speed 14000

RPk

Aff*] ] A *

bax Cut Feed 200 it

Computed W anablez

Spindle Speed 12223 : RPM

Cut Feed [Cf) 97 = inmin

Cancel Help

Dialog Box: Load Feeds from Table

[T] Data from Table

Stock Material

Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

Tool Material

Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

Surface Speed

Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

Feed/Tooth
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Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

(1] Input Variables

The input variables - Work Diameter is automatically loaded from the Stock Radius.
Based on this parameter and the Variables Limits parameters, the program computes
Spindle Speed and Cut Feedrate (Cf). measured in Unites/Revolution. Changing the
spindle speed modifies the cut feedrate.

[T] Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values. Once these two
values are set, the Spindle Speed and Cut Feed calculated by this dialog will not exceed
these values even if you attempt to enter higher values into the Computed Variables
fields. To exceed these values, change them here or you must edit the operation or tool
parameters manually.

[T] Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based on the
selections made in this dialog but will not exceed the values set in the Maximum Limits
for Computation section of the dialog. These values are then assigned to the active
toolpath operation or tool. You can override either of these variables and the other will
update automatically. Since this dialogis a Feeds & Speeds Calculator, you cannot
override both values. To do so, you must edit the operation or tool parameters
manually.

55 Use The Pre Installed Tool Libraries

RhinoCAM MILL. comes with two Tool Libraries (INCH and METRIC) each containing over 50 Tools
that you can use and modify to create your own customized Tool Library. To see a complete list of
the tools in these default libraries, visit the Default Tool Libraries section of this guide.

How to load the default Tool Library:

1. Gotothe Tools tab and select the Load Tool Library icon.
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\ fg Tools
| @rﬁr e Al
B Load Tool librar |

- bt L

Mo Sort 15, | ¥

2. Navigate to the /Data folder of the install path in RhinoCAM.
By default it is located at: C:\ProgramData\MecSoft Corporation\RhinoCAM 20xx for Rhino
x\Data

3. Inthe File Open dialog, change the file type to Tool Library Text Files (*.csv).
4. Selectthe DefaultEnglishTools.csv or the DefaultMetricTools.csv file and then pick Open.

5. The message will inform you of the total number of tools that were loaded.

X

| 56tool(s) successfully loaded from library.

OK

6. The toolsin the library will also be listed in the Tools tab.
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l'_m Tools Gﬁegians \J‘ Features % K-Bases

“lfmb'ﬁf G o Ve Y

T 375 4FL (2550 Loc )

T 3754FL(1.150Loc )
T 375 4FL(.950Loc)
ﬁ % 375 2FL (1.160 Loc )
T 3752FL (900 Loc)
i E 375 4 FL(1.050 Loc )

Mo Sort - *‘%q, 'P

7. If you DO NOT see the tools listed, make sure the icon for List tool only used in operations
IS NOT toggled on.

.rﬂ Tools GRegiuns Q_‘_"li Features E K-Bases

- e

=} Tools A
T 375 4FL (2550 Loc )
S5 AFL [1.150 Lo )
375 4FL (950 Loc )

T 375 2FL(1.180 Loc)
E

75 ZFL 500 Lo )
S5 4FL[1.050 Lo )

PP YW

Mo Sort * fiq, )

¥ih

List only the tools used in Machining Operations

8. You can now edit each of these tools as needed to start your own Tool Library!

© 2026 MecSoft Corporation



32

Cutting Tools Workbook - RhinoCAM-MILL

5.6

Creste/Select Toel

B/BE BV HYELLVO:

Tocls m Session
BALLMILL- 1/4 INCH

TS 4FLI1.050 Loc )

N2IFL[ES0Lac)
250 4 FL[.T50Loe )
B0 ZFL.TS0Loe ]
BT AFL[ES0Loc )
TET 2FL [ E50Loc ]
3TS4FL[ 520Loe)
ATS2FL 520 o)

250 2 FL Wiood Fioughter
370 2 FL Wood Fioughte
.250 Razp Dill Poird Side Grirdes

105 Diemel 1/32 Bal
1252FL[ 530 Lec]
062 2FL[ 35Loc)
1254 FL[ 530Loc)
106 Diemel 053 1/16
105 Disel 0268 1/32
062 4FL[ 35 Lec |
0312 2FL.150 Loc )
ON24FLL 150 Loc )

Add your Existing Tools to a Library

|

Shank

Tool
Langth
Shoulder

Length
Length

19

Tool Diamater

Flute

Hame [ 3754FL{1.0680Loc)

ShakDia Toodllen  Shouderlen |

Fhislen  ToolDia
1.08 & 037

0375 =4 1154 24 (106 =
=

Holdet Holderl w | |

# B2 VNN RRPYS

Diameter ] ;

| Properties Feeds & Speeds
Material CARBIDE w
Cunt Masternial Cobor

Husnbes of Fhaes
Tool Humber

Fufpust Regisher
Cuacom Register
Funl Difzet

A4F AF 4K & 4 4

[ ele| 2 &)

Coolard  Nore w

Comenerds

Save a3 Mew Tool Save Edits 1o Tool [Delete Tool

Exit Help

Dialog Box: Create/Select Tools

If you have existing tool inventory in your shop, the Tool Worksheets located in the Reference
section of this guide can be printed out and used to record the information and dimensions that
RhinoCAM MILL uses to define tools.

Here are the basic steps to get started:

1. Gotothe Tool Worksheets located in the Reference section of this guide and print out the

Worksheet for each tool type.

2. Fill out a worksheet for each of the tools in your existing shop's inventory. Each
worksheet lists the key dimensions that are needed to define each tool in RhinoCAM.
Here is an example worksheet:
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2 g

Holder
Diameter

Shank

Diameter

—

Shoulder
Length

Flute
Length

2|V
HﬂlderTaner_'K

+

Holder
Lenath

Tool Diameter

Mame |

Holder Dia, HolderLen.  H. Taper
Shank Dia.  Tool Len. Shoulder Len.
Tool Dia. T aper fingle

[ E

-

ddgillaiegd:

2 ¥

I &% =V

Vee Mill

Properties Feeds & Speeds

M aterial

Cut b aterial Coloe
Numbet of Flutes
Tool Mumber
Adjust Register

Cutcom Register

I

Astial Dffzat

Coclant  MNome

Camrmgrits

Ak 4k dF AF dF

Properties Feeds B Speeds

Spindle Farameters
Speed - RPM

@cw Ocoow

Drirection

Feed Rates (in/mm)

Plinge  Approach ’E_“%EE
Cut Retract Depariune
Tranzler

(@) Use Rapid () Set

Fesd Rate Reduction Factoss

Flunge betiween levels | = =

First 27 pags | = %

BottomZ Level | sl %

Cut Depth =]
Load from File ..

This is a worksheet to help you document tool paramaters. This 15 NOT a RhinoCAM menu!

3. With worksheets in hand, Create a Tool or load and/or create a Tool Library. See Create a
Tool and Create a Tool Library in this guide for more information about how do this.

4. Note: The tool spec sheet from your tool vendor will have a lot of information. Pay close
attention to which dimensions you need to write down. For example, if your tool has an
insert (i.e., a boring tool), you only need to document the total Tool Diameter.

5. When done entering all of your existing tools be sure to Save your Tool Library and use a
unique file name and location outside of RhinoCAM install path.

5.7

More about the Tools Tab

Here is additional information about the Tools tab:

[T] The Machining Objects (Mobs) Browser, Tools Tab
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ry Tools Gﬂegiuns %Features % K-Bases
TG e e v s Ky

= m Tools

T Flaitil-05

Mo Sort

AP

FlatMill-0.5 | #1 | Dia:0.5, CRad:0, Taper:0 deg | RPM: 3055 | F: 61
The Machining Objects (MObs) Browser, Tools Tab

RhinoCAM supports 2 types of tool library file format *.vkb and *.csv (*.vkb is

recommended).

r—U Tools Tab Functions

Available Configuration

Summary Xpress Standard Expert Professional Premium
(XPR) (STD) (EXP) (PRO) (PRE)
Tools Tab Functions
v v v v v

T

Create/Edit Tools: This button brings up the tool dialog that
enables the creation and saving of tools. All milling, drilling and
user defined tools can be created here. Refer to Tool section
for a detailed description on creating tools and defining tool
parameters.

(&g

v v v v v

Load Tool Library: The load tool library button enables the
loading of a previously saved tool library. Referto the
following section for additional information - Load Tool Library

o

v v v v v

Select Tools from Library: The select tool library button enables
you to select tools from a previously saved tool library. Refer to
the following section for additional information - Select Tools
from Library

ol

v v v v v

Save Tool Library: This button enables the created tools to be
saved in atool library file. The file can be saved in the desired
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directory and read in when required. Refer to the following
section for additional information - Save Tool Library

v v v v v

Unload Tool Library: This button will unload the current Tool
Library.

v v v v v

List Tools: The button brings up all the tool properties
associated with the tools currently recorded in the current MILL
session. Refer to the following section for additional
information - List Tools

¥G !

v v

Compute Tool Holder Collisions*: Determines tool holder
collision with the part geometry. Refer to the following section
for additional information - Compute Tool Holder Collisions

[T Right-click Options on Tools

You can right-click on a Tool listed in the Mobs Browser to perform various functions.
These are listed below:

= Itm Tools

e Flatin 025

s §.375 4FL [ 2550 Loc )

> BECTNRRE it
B arsarL o

H a1 Rename
B arserL cut
& 3410

& wzzrLms Copy
(5 | .25D4FL[.?5E3 bocie
o 0zFL( 7S

H oz e Add to Library
H 20 4FLLA Preview
B zmnar11

L |

"“Right-click Options on a Tool

Edit

Displays the Create/Edit Tool dialog allowing you to edit the Tool parameters.

Rename

Allows you to Rename the selected tool.
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oA Cut / Copy / Paste

These options allow you to Cut or Copy the selected Tool to the Windows
@ Clipboard and then Paste it back to the Tools list to create a new tool using the
E previous tool as a template.

Add to Library
This allows you to Add the selected Tool to an exiting Tool Library *.csv data file.

Preview

This will display a Preview of the selected Tool in the Graphics Window similar
to how the Tool displays during Simulation. The Tool will display at the origin of
the MCS for the current operation.

[T] Tools Toolbar Functions
The following Tool Sorting rules (when set) will apply to both the Tools tab of the

Machining Objects Browser and the Create/Select Tools dialog.

Mo Sort - +‘%+ ,f

Sort by Name - Sorting Selector: This allows you to sort the tool list. You can
select No Sort or sort by Name, Number, Type and Diameter.

+%+ Sort in Ascending/Descending Order: This icon acts like a toggle to
switch between Ascending and Descending sort order.

Jf| List on the Tool used in Machining Operations: Toggle this icon to
list ONLY the tools currently assigned to an operation. Note: You
must Generate an operation for the assigned tool to be listed.

B If you do not see any of your tools listed, check to make sure
this icon is toggled OFF. If no operations are using tools yet
and this icon is ON, then no tools will be listed!
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= .Lm Tools

B allkdillt B Balltill
Borel

CenterDimill

DRILL - 1/4 IMCH
Drrillt

Flathdilll
FLATHMILL-144 INCH
REBorel

Rearner

Tapl

Thread Milll
Weahill

Tools Sorted by Name

m
=
—
g
(7]

< EIX XXy

Tools Sorted by Used

Dj Tools Status Bar

The status bar displays the currently selected tool, tool tip radius & angle, spindle speed
and cut feedrate.

Flat Mill-0.5 | #1 | Dia:0.5, CRad:0, Taper0 deg | RPM: 3055 | F: 61

Status Bar, Tools Tab, Machining Objects Browser

5.8 More about the Create/Select Tools dialog

Here is some additional information specific to the Create/Select Tool dialog:

1] Tool Holder Types

Tool Holder

Xpress Standard Expert Professional Premium
(XPR) (STD) (EXP) (PRO) (PRE)

Types

Vertical
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Tapered

Multi-Segment

[1] Tool Types by Configuration

pon) | 1o | om | wmoy | eee
Ball Mills g v v v v v
Flat Mills a| v v v v v
Corner Radius Mills | (4 | v v v v
Vee Mills Vi v v v v v
Chamfer Mills (5 v v v v
Taper Mills ‘;! v v v v
Thread Mills 3 v v v v
Face Mills A v v v v
Dovetail Cutters & v v v v
Fillet Mills 1 v v v v
Lollypop Cutters Jd v v v v
User Defined Cutters | |2 | v v v v
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Drills

Center Drills

L S|

Reamers

Taps

Bore Tool

Reverse Bore Tool

Knife Tool

Saw Tool

Plasma Tool

=18 1B 9 I i

L N N N N N I N R N B N

S N N N N O N I N O N B N

R N N N N N N N N

SN N N I N B N RN N R N RN
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Tool Related Answers

It is recommended that you do not attempt some of these more Advanced Topics until you are

familiar working with tools and tool libraries in the RhinoCAM MILL module.

6.1 Where can | find Tool related Preferences?

Listed below are the CAM Preferences that are related to Tools and Tool Libraries:

1. Locate the CAM Preferences icon to the right of the Program tab and select it.

2. Select the User Interface item from the left. Here are a couple of Preferences that will help

you with the tools related dialogs:

Show context ToolTips

Check this box to display Context ToolTips when the mouse moves over a parameterin a
dialog. A definition of the parameter will pop-up automatically. Note that Context
ToolTips may not be available for ALL dialogs. You can also set the ToolTip Delay in
seconds. This is the amount of time it takes to display the Context ToolTip when the

mouse activate it.

-1} Juista

oo : '
= distance for the current operation as a
| percentage of the active tool diameter

r Ciinside () Outsade -:-'“Em Fa
L1l Abways Kewp Tood Down
Genesahe Cancel Sane

k4 ﬁ(ﬂ“ 125 | 53] e
[:

% Tool Diameter allows you to set the stepover

Help

Show Expressions in Tooltip

You can enter expressions in any dialog field that expects a numerical value and the value
will be computed and entered automatically. Check this box to pop-up the results of any

expressions in a ToolTip balloon. An example is shown below.
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Location of Cut Geometmy
(&t Top  (®) At Bottom

(O Pick Top 0 sk

Cut Depth Contral

Total Cut Depth: = I
Fough Depth:
05 = £

Show Expressions in ToolTip

3. Select the Cutting Tools item from the left.

Preferences <
Leametry Cutting Tool Colors
Features ToolFlues | | = ToolShank || -
Stack,
[ Cutting Tools | Tool Holder .
Feeds & Speed
FECs apEets Tool Dizplay
b achining

@ Salid () Transparent  (wireframe () Mone
Output Contral

[ ] Display Tool Holder
Toolpath

Sirulation
zer Interface

Post Processor

Tool Libram Preferences

Always load last lnaded toal library on startup

Default Tool Librany

Licensing | C:%ProgramD atath ecSoft CorporationtisualCa

Clear

Cancel Apply Help

CAM Preferences > Cutting Tools
Note: Menu selections on the left may change depending on module and configuration

4. You can select the Default Tool Library to load for new part files. You can also check the box to
Load the last loaded tool library on startup. This will ensure that your Tool Library loads every
time the program runs.

5. You can also set the Colors used when the Tool is displayed on the screen.
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6. Now select the Feeds & Speeds section from the left.

7. Here you can decide if you want default Feeds & Speeds loaded from the Tool for new
operations. If you set this to Tool and define your Speeds & Feeds for each of your tools, you
can be sure those Feeds & Speeds are being used when a new operation is created that uses

that tool.
Preferences *
Geometry Load Feedrates for new operations from
Features (®) Toal () Feeds & Speedz File () Defaults
Stock
. % 3 to usze for tranzfering from computed cut feed
Cutting T onls
|1IZIIII = 3
Feeds & Speeds l Cut Feed (C1] = = t
ey
tachining Plunge [Ff] |5III <. CutStart 4
L
CQutput Control Soproach (A |75 - %
PR ol I: hs Clearance )
Toolpath
F Engage [Ef] |?5 2, (J / Ef
Sirmulation T
Retract [Rf] 125 ] .
zer Interface I: X =
K
Post Processor Departure (D] 150 % Of Cf
Licensing Transfer [TF | 200 = % E;

Feeds/Speeds Tracking Options
[] &lwsayz track Operations Feeds/Speeds to used Tool

Cancel Apply Help

CAM Preferences >Feeds & Speeds

8. You can also set the % of the computed Cut Feed to use for the various types of transfer
motions. For example, in the Feeds & Speeds Calculator (displayed when you select Load
from File from either the Create/Select Tools dialog or from the Feeds & Speeds tab of any
operation type) a Cut Feed value is calculated and suggested. These percentages listed in
this CAM Preferences dialog will determine how much of that Cut Feed value is used for
each of they remaining tool motion types.

9. You can also check the box to Always track Operations Feeds/Speeds to used Tool. When
this is checked, changing the feeds/speeds parameters of a tool and saving the edits, will
automatically update the feeds/speeds on each operation that utilizes this tool in addition to
marking the operations as dirty.
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=, Machining Job
Machine - 3 Axis
Post - Haas
Stock - Box Stock

o

o
L]

o

Fixtures - Mone
. Setup 1
“ Work Zero
*| Horizental Roughing
t
|| 21/2 Axis Profiling
EIE. Setup 2
e Work Zero
*| Horizental Roughing
3

iy

=13

l

Parallel Finishing

Parallel Finishing

6.2 How can | Print a Tool List?

Follow the steps outlined below to print your Tool List:

1. The Tool Listis based on the tools currently listed under the Tools tab of the Machining
Objects Browser. If you want to print your tool library list, first Load your Tool Library so
that all of your are listed in the Tools tab. See Create a Tool Library to learn how to Load
your Tool Library.

2. Fromthe Tools tab, select the Tool Listicon:

]'.g Tools Gﬂeginns I‘__,Features Fo K-Bazes
! F % I o
- i
=T oo ook

lﬁ. AVEAFL (2,550 Loc )

lﬁ. 375 4FL (1150 Loc )

T 375 4FL (950 Loc)

3. Fromthe Cutting Tools Information dialog, pick the Print button.
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6.3 How can | add a Custom Tool?

Available in: Xpress Standard Expert Professional Premium

v

The MILL module allows creation of special purpose tools like form tools. These can be defined
under user defined tool in the create/select tool dialog.

\J User Defined Tools can be used in Drill operations to allow multi-
function tools to be defined as user defined tools and used in
drilling operations. See User Defined Tools for more information.

1] Steps to create a user defined tool

Stepsto create a user defined tool

Steps to create a user defined tool:
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1. Draw half the tool profile from the top view (XY plane of the world coordinate
system) as shown in the picture above and then join the curves to form a single
curve.

2. Make sure one end of the curve (tool tip) is at origin (0,0) and the other end at
X0, Y<value>.

3. From the Tools tab under the Machining Objects Browser, click Create/Select
Tool and select User Defined Tool.

Create/5elect Tool
g8 u|mr;\at|,u.\.',',\u|u\i_gﬁ|w\|||\al|1\»
P Y N . = [T e T 9T

click Create/Select Tool and select User Defined Tool

4. Click Load selected tool profile curve.

| Load selected tool profile curve ... |

Holder Diameter

M arne UeerDeftdill

Holder Dia.  Halder Len.
1 = i T

| sl w

Load zelected tool profile curve .

Click Load selected tool profile curve

5. Specify the Holder Diameter, Holder Length, Properties, Feed & Speeds and Click
Save as New Tool.
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1] Preview your Tool

Preview Tool allows you to preview the highlighted tool in the workspace as seen below.
The tool is previewed at the WCS origin.

Preview your Tool

6.4 Why are my Feed Rate values too High/Low?

If your Feed Rate values in your posted g-code are too High or too Low, you can adjust the
High/Low parameters in the Post Processor following the steps outlined below:

1. Click on Post (Set Post-Processor Options), then click Edit.
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MILLll'Lﬂ Pragram Simulati Select Post-Processor

Machi Stock ~
a8 Machine 6 Be ‘I Select Post-Pracessor

i Post % Align = =]
£l get,_,p‘v\; Material =~ Fost-Processor Tupe

(®) Llze Legacy Post (") Use Programmable Post

Machine Setup Stock Current Yersion: 2021.2

=1, Machining Job
y Machine - 3 Axis
5_;? Post - Haas
[Ei Stock - Box Stock

Fixtures - None

Select Post Processzor

Current Post Processar:

Haaz w || Edit ...

a7

Ider to load post-processor files from:

C:A%ProgramD atahMecSoft Corporation RhinoCak 2027 for
Setup 1 Rhino B.04PaostzhMillhS PR

2 1/2 Axis Facing

L

|__ 21/2 Axis Pocketin
|__ 2172 Axis Pocketin
| 2172 Axis Profiling

m
HHHHM’»@

Cancel Help

2. Fromthe Post Processor Generator dialog, select the Feed Rate tab from the left.

3. Then make the necessary changes under the Feed Rate Value section for either the High
Value or Low Value.

Post-Pracessor Generator

General
Stal/Erd Block Foamat = -
Tool Change Feed Fate Code [ i aftes Meatt Motion Code Ireesze Time Feed Rste
Setup L ) ) o
Spiredle Fead Rate Modes ] Dutput irwenze time leediate for 4 & 5 fuds molions
- -
Hation Lirats/Min Code Un#s/Fev Code: On Code: QI Code:
Cacle | J
Hebcal/Spial
Muiti Asiz Mobion Block Faimat
Cutter I:_cemm FIFEEDRATE]
Cut Motion Start/End
#- Cycles
Dt
Mise Sample Dulput
Vansbles Fi
Feed Fate Value
HighVake | 1000/% ScdeFactor [ 113 ZFeedRaeScaeFactor | 1%
Lowvae | 1% HolDecimal Flaces | 02 Show Trailing Zeros
Angular Feedrate Value
ScaleFactw | 112 HolDecimal Places | 112 Show Traing Zeraz [

Save Close: Save As... Hedp

4. Then pick Save.
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6.5

6.6

What about Tapping Feed Rates?

For tap operations, the feedrate can be computed in different ways. This depends on what is

expected by the controller.
Spindle Speed x Thread Pitch
Thread Pitch

1/Thread Pitch

Cut Feedrate

The post needs to be setup with the appropriate variable to output the feedrate. The Thread
Pitch is defined under the Tool definition and Spindle Speed is set under Feeds/Speed tab of the

Tap operation.

Use the following macro’s in the post to output the feedrate
[CYCL_IPR] —Spindle Speed x Thread Pitch

[CYCL_TPI] —Thread Pitch

[CYCL_1/TPI] —1/Thread Pitch

[CUT_FEED] — Cut Feedrate

How can | Optimize Machining Time Estimates?

[1] Optimize Machining Time Estimates!

In any MecSoft CAM product you can get an Information report
about a selected toolpath operation, a Setup or all operationsin
the Machining Job. This report contains some very useful
information that includes the Tool #s used, the Cut Feed, the # of
GOTO motions and most importantly, the estimated Machining
Time.

Read the full article...

Machine Tima

3hr 32min
10 e 20 min

IERETTTTE
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More Advanced Topics

71 How can | add Tool Comments?

You can add comments associated with a Tool. These Comments are saved with the Tool in your
Tool Library. They are also posted to your g-code when the tool is used.

Here are the steps to add Comments to a Tool:
1. Editthe Tool usingthe Create/Select Tool dialog.

2. Selectthe Properties tab on the right.

gaBavHEYELLYOEBVNNRERY *
Tools in Session HoldE'Taner_,L{{_ Ll ] Properties Feeds & Speeds

Holder HHH Matedsl | CARBIDE <
Length ! I

Holder

Diameter { { Cut Materisl Color (I ~
1 | 1 1 2
Ghank ! ! Muribest of Fhtes

Diameter 1 1 Tool Numbes 1
Too  EEEEEHE . £

Length t t o p

Shoulder Sl —F— [ | S 0] CutcomPRegster |1

m
el Sl Diff et Li]
Length : ': | | Cootsnt |Hone bt
Comments

Tool Diameter { *
Name |Flabii | [iiiifiidg

SharkDia Toollen  Shoukds Len
12 [=l[0 [ [ [
FhteLen.  Tool Dia

W =l =

Holder| Dnafait Holdes dl | 2
Save at Mew Tool Save Edis o Tool Dielete Tocl
< > Cencel Helo

3. Add text tothe Comments window.
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Properties  Feeds & Speeds

Material | CARBIDE

Cut Mateial Color [ |+
Murnber of Flutes
T ool Mumnber
Adjust Reqgister

Cutcom R egister

4

0

0

—
fial Offset E
Coclant | Hone

Comments

by Tool Comments herel

4. Make sure Comments are enabled in your post.

A. Click on Post (Set Post-Processor

Options), then click Edit.

MiLL |3

Program Simulate_ Select Post-Processor >
Machi Stock -
» aenine 6]7'1 oc ‘: Select Post-Processzor
i Post @ Align ~ | =
= Setup\z Material =~ Post-Processor Tope
(®) Uze Legacy Past () Use Programmable Post

Machine Setup Stock /

Machining Job
= I"l achining ] ° ) Select Post Processor

Q? Machine - 3 Axis Current Post Processor:

. / Post - Haas Haas <! Edit

f:ﬂ Stock - Box Stock . %

i N |der ta load pozt-proceszor files fram:
@ petures - None C:hProgramD ataiMecSaft CarparationsBhinoCak 2021 for
= ﬁ Setup 1 Rhino 6. 04PaoztshMillhS P

(Y 2 1/2 Axis Facing

|__ 2172 Axis Pocketin

|__ 2172 Axis Pocketin

| | 21/2 Axis Profiling

Cancel Help

B.

From the Post Processor Generator dialog, select the General tab from the left.
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C. Checkthe box to Output Comments. You can also change the start and end
characters to use.

Pest-Processor Generador  C'\ProgramDista’\ MecSoft Corporation'\VisualCAM 201 T\ Pasts\ MILL\ WinCHC.spm *
Stmn/Erd File: Conibol Mode Comments
Todl Change
Sehp
pndie Fie Stast Fieading Chat @ bikts  Code|GH0 ] Dutges Cosmrmena
Faad Rats . .
Motion : : Corrment StatChar || |
Cacle . : ‘
Helcal/Spid Fi Stop Readng Chas | Qteromerial 5 Comment End Char ||
Mg fsds Miokion
Cumer Compansstion ] Dutgast sevpsnce ramber
ot Miotion Stat/E red 5 . ks
4 Cycles Bt
Mizc
= Block Format
Vigsybis [l Use Sequence =
) @ Inch Code G20
Drefiemiber

CiMone () Space () Tabe

2 Matrc
() Uses Diesfined
Mokl Qudpud End of Block Chaiseter |
[JGCod [ Foodate 0 Abwcys cutgnt  sign
A% ] Comdnate 4 Spandie speed ] Shaww Leading Zeia

Close Sarvn i Help
D. Then pick Save or Save As.

5. Now post your operations and see your comments:

G1 X0.5301Y-0.7171 70.7480

G3 X0.7801 Y-0.4671 10.0000 J0.2500 F2.6
G1 X0.7801 Y-0.2171 70.7480 F6.9
G0 Z0.9843

GO0 X0.7801 Y-0.2171

(2 1/2 Axis Profiling)

(My Tool Comments Here!)
$18000

GO0 20.9843

GO X0.5301 Y-0.7097

G1 X0.5301 Y-0.7097 20.7480 F6.9
G1 X0.5873 Y-0.7097 20.7480 F3.4
G1 X0.5873 Y-0.6345 70.7480

G1 X0.4729 Y-0.6345 70.7480

6. If you want to post g-codes instead of comments, just place a S character prior to the
comment in the Create/Select Tools dialog. Adding S as prefix will skip the comment start
& end characters in the posted code.
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7.2

Properties  Feeds & Speeds

Material | CARBIDE e

1

Cut Material Color

Mumber of Flutes

A ]*

T ool Number

Adjust Reqgister

A (k{1 ] *

Cutcom R egister

Bial Offzet

L

Coclant | Hone o

Comments

$hy g-code Herel

G1 X0.4655 Y-0.7171 20.7480

G1 X0.5301Y-0.7171 20.7480

G3 X0.7801 Y-0.4671 10.0000 J0.2500 F2.6
G1 X0.7801 Y-0.2171 20.7480 F6.9
G0 Z0.9843

GO0 X0.7801 Y-0.2171

(2 1/2 Axis Profiling)

My g-code Here!

$18000

G0 Z0.9843

GO0 X0.5301 Y-0.7097

G1 X0.5301 Y-0.7097 20.7480 F6.9
G1 X0.5873 Y-0.7097 20.7480 F3.4
G1 X0.5873 Y-0.6345 70.7480

How can add a Tool Change Point?

Implementing a Tool Change Point can be useful. For example in 2 and 3 Axis, you may want to
change tools manually between operations (i.e., your CNC machine does not have an automatic
tool changer). Alsoin 4 Axis you may want to ensure the tool is moved to a save location priorto a
table rotation. To output a Tool Change Point to your posted g-code files, please do the following:
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[T] For 2 and 3 Axis Output

1. From the Machine Setup dialog (Program tab > Machine > General Parameters >
Tool Change Pt), enter your required tool change point coordinates.

2. Forthe sample code (shown at the end of this section) we entered the following
values in the Machine Setup dialog:

X:-4,Y:0Z:0

Machine Tool Setup >

kaching Toal Definition

(®) Manwal D efinition {" Load From File
t achine Type
Murber of Axes | 3 Axiz e

General Parameters

Tool Change Pt K: “r’||:| = Z|d |: Ly

COutput all coordinates in lozal Setup Coordinate System

Tranzlational Limitz
M ><: v[so00 2] z[g000 |2
Maw = = |5EIEIEI

ST
Ath Axiz [Prirnary Axis) Parameters
1] = 1] = 1 = II;E

- - -

3. Edit your post processor by selecting Program tab > Post > Edit.
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4.

|"~"|||_|_|Lm Program

M Machine @ Stock gl

_Simulate_ Select Post-Processor >

Select Post-Processar

i Post % Align - ﬂ
T Setu& Material = -l Post-Processar Tope

Machine Setup Stock

(®) Use Legacy Post () Use Programmable Post
Curmrent Verzion: 2021.2

= Machining Job

3 Machine -

:_;7 Post - Haas

3 A Select Post Processor
= Curent Post Processor

Haas w || Edit ..
fj Stock - Box Stock . L\\s
. N lder to load post-processor files fram:
@ wtures - None C:4ProgramD atahhecS oft Carparation s RhinoCaM 2021 for
= E Setup 1 Rhirg B.04Pazts\MilhS P
R 2 1/2 Auxis Facing
|__ 2 1/2 Axis Pocketin
| | 21/2 Axis Pocketin
| | 27/2 Axis Profiling

Cancel Help

From the Post Process Generator dialog, select the Tool Change section from the
left side of the dialog.

In the Tool Change Macro block section, replace the first line of text with the
following two lines of text at the top of the macro.

These two lines of text should precede the line that includes T[TOOL_NUM] as
shown in the examples below.

[SEQ_PRECHAR][SEQN
[SEQ_PRECHAR][SEQN
[SEQ_PRECHAR][SEQN

Puost-Processor Generator

General

UM][DELIMITER]GO Z[TOOL_CHG_PT_Z]
UM][DELIMITER]GO X[TOOL_CHG_PT_X] Y[TOOL_CHG_PT_V]
UM][DELIMITER]T[TOOL_NUM]

Stat/End ) Uz 2 chgit fommsat fior Tool rumber and registers

Tl Change

Sehp Fiest Lod Tool Macio

Spinde

Feed Rate |SEQ_PRECHAR)SEQMUMDELIMITER]SPINDLE[DELIMITER ON[DELIMITERS FEED[DELIMITERSPINDLE_SPDDELIMITERFORWARD
Mation 1SEQ_PRECHARISEQNUMDELIMITER)OUTFUT_MODE_CODEIDELIMITERIG_CODE ENEXT_HONMODL_Z]
Cicle 1SEQ_PRECHARSEQNUMIDELIMITER)G_CODE PINEXT_NONMDL_XIDELIM TERNNEXT_NONMOL_Y]

Hebcal/Speal

Huki Axis Motion

Cutter Compen:zabon

Cut Motion Stat/End
+- Cyches

Misc

Yanables

Tool Change Macio
SED, FFEF‘.HAR]_"" il Hl[ELIMITI-_FI G0 Z(TO0L_C

ARYS JELIMI CHG
EQ PF!EU'LAR[SEDHUMIDELIMITEHITITEIUL_NUM

'5
[SEQ_PRECHARISE ONUM IDELIMITER [SPINDLE[DELIMITERON[DELIMITERJS PEEDIDELIMITER ISPINDLE_SPDIDELIMITERFOFWARD
(SEQ_PRECHARISEQNUMDELIMITER)OUTPUT_MODE_CODERDELIMITERYG_CODE EMEXT_HONMODL_Z]
|SEQ_PRECHARYSEQNUMJDELIMITER)G_CODERNEXT_NONMOL_XJDELIM TERNTHEST _MONMOL_Y)FEEDRATE_BLK]
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6.

10.

11.
12.
13.
14.

If your controller expects to see an optional stop call BEFORE each tool change,
you can add another line like below:

[SEQ_PRECHAR][SEQNUM][DELIMITER]GO Z[TOOL_CHG_PT_Z]
[SEQ_PRECHAR][SEQNUM][DELIMITER]GO X[TOOL_CHG_PT_X] Y[TOOL_CHG_PT_V]
[SEQ_PRECHAR][SEQNUM][DELIMITER]MO1
[SEQ_PRECHAR][SEQNUM][DELIMITER]T[TOOL_NUM]

From the Post Process Generator dialog, pick Save As.
Enter a unique name for your post file (*.spm) for testing and pick Save.

From the Set Post-Processor Options dialog, select the revised post from the
Current Post Processor list.

X

Select Post-Processor

Select Post-Processar

FPozt-Processor Type

(®) Use Legacy Post () Use Programmable Post

Select Pozt Processar

Current Paost Processar;

Chichd asters- etric Edi ...

Crcjr
Chichd asters-lnch

far

CHTMation
CR-OMSRUD_AMC
CR-OWNSRUD_BER
CR-OWMSRUD_0O5aI
Creativel

crizader

Cratron
Fi=sbrmmd 1

Help

Note: If you do not see your revised post in the list, select the "..." button to the
right of the "Folder where post-processor file are located" and select the folder
where you saved your revised post file to (see Step 7 above) and pick OK.

You should now see your revised post in the list. Selectitand pick OK.
Post a sample toolpath using the revised post.
Review the g-code test file and locate the first tool change lines of code.

Your sample test should look something like this depending on your post (based
on the tool change point we used in Step 2 above). Note the tool change
coordinates in blue:
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N66 ;2 1/2 Axis Profiling
N68 GO Z0.

N70 GO X-4. YO.

N72 T1 MO6

15. That's it!

[T For 4 Axis Output
1. From the Program tab select 4 Axis.
2. From the 4 Axis menu select 4 Axis Options.

3. Fromthe 4 Axis Operation Options dialog check the box to Always retract tool to
Tool Change Point before each Table Rotate Operation.

4-Axis Machining Operation Options

Alhwapz retract tool to Tool Change Point before each T able Ratate Operation

Alwaps warn if ratation center iz not aligned with = or'y axis

[] Do not output intermediate points for transfers motions

Help Cancel

4. Now from the Program tab select Machine and then Manual Definition.
5. Forthe Machine Type select 4 Axis.

6. Under General Parameters, enter the X, Y and Z coordinate values for the Tool
Change Point.
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Machine Tool Setup by

kachine Toal Definition

(®) Manual D efinition () Load Fram File
t achine Type
Mumber of Axes | 4 Axiz “ | LConfiguration | T able e

General Parameters

T ool Change P KIII: 'Y||:| : 2|1D : EE

Dutput all coordinates in local Setup Coordinate System
. . .

Mire 3¢ 200 |= Y|'EDD [ EETI =]

7. Then check the box to Output all coordinates in local Setup Coordinate System
and then pick OK to close the dialog.

8. Postthe 4 Axis toolpath operation and verify that the Tool Change Point is being
posted before the table rotation angle similar to this:

(Setup 2)

N6263 710.

N6264 X0.YO.
(Horizontal Roughing)
N6265 A180.F300.

7.3 How can | add more Materials?

This topicis intended for advanced users who are familiar with XML text editing and have
administrative access to their Windows Operating System. RhinoCAM has a built-in Feeds &
Speeds Calculator that can suggest Spindle Speeds and Cut Feed Rates based on your stock
material and active tool parameters!

However, what if you are cutting stock material that is currently not in our Materials Library? Or
what if you don’t like what is currently assigned for the material of your choice in the Materials
Library?

This topic will show you how to customize RhinoCAM to add and manage multiple material files as
well to add your own stock materials. If you are new to RhinoCAM, you can review the topic The
Feeds & Speeds Calculator.

[T] How Materials are used
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[T]

First let’s review how material definitions are used in RhinoCAM. From the Stock pane
of the Program tab in the Machining Browser you will find the Material icon. Selecting it
will display the Select Stock Material dialog. Here you can select a stock material from
the Material File. If there is an associated Material Texture file, then this texture is
assigned to the stock model and rendered in the graphics window. This texture

rendering on the stock can be toggled on or off using the Material Texture Visibility icon,
located at the base of the Machining Browser.

Select Stock Material hod

Chocse Shock Materisl

MILL|B| Progrom | Simulate o F-E9 Material Fie
M Machine ) Stock = o™ WorkZero  Beg 4 s = 3§, - FeedsSpeedsDatalNCH.xml
15 Post miign = | = 2.5 - S fodis ~ 2R v
8 o \4 pr—
Setup - || 3= Mateiol | AT 3 s Adv - f‘-.’-l'] Hales =
Machine Setup Stock Machining Operations WooD o

g Material Texhure
3 M i= Define Stock Material
i pe =

MILL Module shown, Similar for MILL-TURN,
TURN and Profile-NEST

6 B]al]a H of F 28 peut < |
L
Material Texture Visibility

VisualCAM - o x
| = Toggle Material Texture
“f Toolg o Vls?bglhty on Stock % K-Bases
T Scaed 1 BT Source folder for material fles:
=) Tools ~ -
T 37541 2550 Loc ) .HmﬂawWCﬂwaM|
- T Lo
The Material iconsin the Machining Browser /
Cancel
MILL Module shown, Similar for MILL-TURN, E i
TURN and Profile-NEST The Select Stock Material dialog

Also, from the Feeds & Speeds tab on the Create/Select Tool dialog you can select Load
from File to display the Feeds & Speeds Calculator dialog. The Material selection in this

dialog will default to the stock Material you have previously selected from the Select
Stock Material dialog (shown above).

Location of Material Files

The Material selections available to you from these dialogs are retrieved from a Feeds &
Speeds XML file installed with the program. There are separate files for INCH and

METRIC units. The files are located in the \Materials folder of the ProgramData install
path of the program.

Here is an example: C:\ProgramData\MecSoft Corporation\Program Name &
Version\Materials.

n By default, the Windows Operation System does not display the
ProgramData folder to you. If you do not see it, login as
Administrator and from the Windows Control Panel, navigate to the
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File Explorer Options dialog, select the View tab and then select the
option to Show hidden files, folders, and drives and pick OK.

[ Maintaining Multiple Material Files

You can create your own Material Files and store them in the default folder. The CAM
system on startup will load all material files in the folder specified in the dialog above as
long as the units of the material files match the part units that you are working with. If
the system finds multiple material files with matching units, it will populate the drop-
down control in the Materials dialog allowing you to select a specific material file to suit
your needs.

ﬁ You need to make sure that you have the units specified correctly

in your customized materials XML files or your material files will
not appearin the dialog list. See item #5in the Editing the Feeds &
Speeds XML File section below for the correct Units format.

Having multiple material files can help manage different materials and associated feeds
& speeds data without having to cram all of the data into one file. In addition, multiple
material files may be useful if you have multiple machines in the shop with different
power capabilities and you want to use different feeds and speeds settings per machine.
Under this scenario you could have one material file per machine saved in the default
folder and load the correct material file depending on which machine you are
programming toolpaths for.

[ Editing the Feeds & Speeds XML File

Material files can be edited to customize the data stored in these files to suit your shop
needs.

ﬁ CAUTION!! - Before editing material files - Make sure you create a

copy and keep them in a safe place, outside of the install path of
the program. Also, make sure you maintain the XML format of these
files or the Feeds & Speeds Calculator may not work properly! The
file names are:

FeedsSpeedsDatalNCH.xml
FeedsSpeedsDatalNCH.xml

Here are the steps required to add new material definitions. Be sure to read these steps
carefully:

1. Make a backup copy of the Feeds & Speeds XML files!
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2. Edit the XML file to add the material definitions needed, paying close attention
to the format of the XML file. This file can be edited with any ASCII text editor
such as Notepad or any XML editor.

3. Each Material defined in the XML file has several records (or lines of text)
associated with it. Each line of text defines information about that Material for
each instance itis referred to by the Feeds & Speeds Calculator. Here is a sample
section for Aluminum.

<Version>1.0</Version>

<Units>Imperial</Units>

<FeedsSpeeds>

<Material>
<Name>ALUMINUM - 2026</Name>
<TextureFile>ALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>

</Material>

Here is what the file looks like in tabulated form:
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Stock Toolpath Tool Surface T
Material Type Material Speed i ]

ALUMIMUM - 2024 MILLING | CARBIDE | 1600.00 0.0040
MILLING H35 40000 0.0040
MILLING | CERAMIC | 400.00 0.0040
DRILLING | CARBIDE | S&0.00 0.0048
DRILLING H35 240.00 0.0048
DRILLING | CERAMIC | 240.00 0.0048

TURNING | CARBIDE | 1800.00 0.0200

TURNING | CERAMIC | 1800.0:0 0.0200

TURNING | CERMET | 1800.00 0.0200

ALUMINUM - 5050 MILLING | CARBIDE | 1600.00 0.0040

MILLING H35 40000 0.0040

E O N "‘-"HW'“_W

You will need to know the Surface Speed and Feed/Tooth specifications for each
instance of the Material you are adding to the XML file. Here is the information
format:

<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>

You need to make sure that you have the Units format specified correctly in your
custom material XML files. Itis defined on the 2nd line of the Materials XML file.
For Inch units use <Units>Imperial</Units>and for Metric units use
<Units>Metric</Units>as shown here for Inch:

<Version>1.0</Version>
<Units>Imperial</Units>
<FeedsSpeeds>
<Material>

There is also a bitmap image file (*.bmp) associated with each Material type
defined in the XML file. This image defines the texture thatis applied to the
Stock material when the Toggle Material Texture Visibility icon is enabled. The
image is also displayed in the Select Stock Material dialog.
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Select Stock Material hod
Choose Stock Material

Material File

FeedsSpeedsDatalMCH.xml

Material

ALUMIMUM - 2024 -

Material Texture

Source folder for material files:

gramData

Cancel Help

Dialog Box: Select Stock Material

Here is the list of the material texture map files currently installed. Make sure
your bitmap image file name matches the name entered into the Materials XML
file or the No Texture Map icon will display instead.
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Alurninum. bmp Brass.bmp Castlron.bmp Copperbmp FeedsSpeedsData FeedsSpesdsData

INCH.omil AN 2xmil
!J .
4

R — —
Graphite.brnp Hastelloy.brmp Inconel.bmp Iron.bmp Magnesiurmn.brmp  Molybdenum.bm
P
Tia Teimma
Ll
Manel.bmp Mickel. brnp NoTextureMap.b Plastic.bmp Steel.bmp Titaniurm.brmp
mp

Waspaley.bmp wood bmp

D:l Let’s Review

Adding specific materials you use regularly in your shop to the Feeds & Speeds Calculator
in RhinoCAM can save toolpath programming time and help ensure cut surface quality
and machining time accuracy. Just be sure to review this post carefully. A summary is
also listed below. If you need help, you can always contact us at MecSoft Support via the
phone, web or email.

1. Youcanselect a Material to be applied to your Stock definition.

2. The selection of materials are retrieved from an external data file (example:
FeedsSpeedsDataINCH.xml) located in the install path of RhinoCAM on your
computer.

3. The XML datafile can be edited with any ASCII text or XML file editor.

4. The XML data file also contains information about the CAM Module, Tool
Material, Surface Speed and Feed/Tooth for each instance of the material.

5. The stock material selected is used by the Feeds & Speeds Calculator to suggest
Surface Speeds and Cut Feed Rates.

6. The Feeds & Speeds Calculatoris displayed when you select Load from File from
the Feeds & Speeds tabs of the Create/Select Tool dialog or from each toolpath
operation dialog.
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7.4

7. You can manually add more materials to the XML data file. You will need to know
the recommended Surface Speed and Feed/Tooth specifications for the material
you are adding based on each Tool Material type.

8. ltisvery IMPORTANT that you make a backup copy of these XML files if you plan
to edit them. Also, the text format of the XML files is VERY IMPORTANT. If the
formatisincorrect, the Feeds & Speeds Calculator may not work properly! Make
sure that the Units format on line 2 matches the Units you plan to use in your part
files.

9. Each material also has a bitmap image texture file (*.bmp) thatis located in the
same folder. The material texture image is shown in the Select Stock Material
dialog and is also applied as a texture map to your stock when the Toggle
Material Texture Visibility icon is enabled.

How can | enable Cutter Compensation?

All toolpaths except engraving are automatically compensated for the tool geometry. Cutter
compensation is used typically to compensate for the difference in the dimensions of the actual
cutter used in machining and the cutter used for programming in RhinoCAM. For example, if the
cutter used in programming is 0.25 inches and due to tool wear the actual cutteris only 0.24 inches
in size, you can compensate for this at the controller rather than having to re-program the
operation in RhinoCAM.

Cutter compensation is used extensively in production (high volume) machining where the
machine operator can compensate for tool wear before having to stop and replace the tool or
insert.

In order to do this the user needs to do the following:
1. Turn cutter compensation on in the operation to Auto/ON or CONTROL/ON.

2. Specify the cutter compensation value and the compensation register in the controller
(the controller needs to be capable of doing this).

3. Please make sure the post processor is configured to output cutter compensation. This is
defined under the Cutter Compensation section in the post processor generator. Most
controllers expect an X & Y motion on the same line as cutter compensation.

Cutter Compensation Left

[SEQ_PRECHAR][SEQNUM] G41 [G_CODE] X[NEXT_NONMDL_X] Y[NEXT_NONMDL_Y] D[TOOL_CUTCOM_REG]
Cutter Compensation Right

[SEQ_PRECHAR][SEQNUM] G42 [G_CODE] X[NEXT_NONMDL_X] Y[NEXT_NONMDL_Y] D[TOOL_CUTCOM_REG]
Cutter Compensation Off

[SEQ_PRECHAR][SEQNUM] G40
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Post-Processor Generator x

General

Start/Erd Cutter Compenszation Left

;zp':hm |SEQ_PRECHARNSEQMUM) G41 [G_CODE | =MEXT_HONMDL_¥] vTMEXT_MOMMDL_) O[TOOL_CUTCOM_REG]
Spiredby

Feed Fate

Mation

Cicle

HebcalSpeal

Ml Az Motion
Cut Motion Stat/End E‘-,‘ Cudter Compensation Right

- Cycles |SEQ_PRECHARSEQNUM] G42 [G_CODE | AMNEXT _HONMDL_x] ¥THEXT_NONMODL_Y) D[TOOL_CUTCOM_REG]
Misc
Wariables

Culter Compenzation Off
(SE0_PRECHARYSEONUM| G40

Save Close Sarve Az... Help

A few things to watch out for:

1. Cutter compensation makes sense only in 2-1/2 axis operations. If you are using roughing
(pocketing & facing) the compensation will be turned on only in the final passes.

2. Make sure you are using Climb or Conventional cut traversal in any of the methods that
you want to turn compensation on.

2 1/2 Axis Profiling >

CutlLevelz:  Entm/Exit  Advanced Cut Parameters  Comering Parameters Sorting
Control Geomety Tool Feeds & Speeds Clearance Plane Cut Parameters

Global Parameters )
Region

- " =
Taolerance; |0.001 —F
s 4 I..-'"' Toolpath

[
Tolerance

Compenzation: | ATRIREILTE : -

ATOHONE Compensation refers to cutter compensation. You can turn

& T0/0N this on by selecting from the drop down menu. The cutter

Cut Direction CONTROL/OM compensation direction, left or right, is determined by the Cut

@ Climb Down C Direction defined (Climb or Conventional). Refer to Cutter

imb [Dovin Cutl Compensation for additional information.
0O P
Corventional [Up Cut)

() Mixed
Cut Start Point for Clozed Curves

Lze Mid-Point of longest side

3. Make sure you have a linear motion for the controller to turn on the compensation for. If
your first motion is an arc the controller will not be able to turn on the compensation.
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Thus, in 2-1/2 axis profiling, make sure there is a linear entry motion for the controller to
be able to turn compensation on & linear exit to turn off compensation.

If you are looking to compensate for the full tool diameter, set Stock =-0.125 under the cut
parameters tab. (0.125 being the radius of the tool). This would generate the toolpath ON the
curve. This would invalidate the simulation as the tool tip stays on the drive geometry.

Note: The Cutcom Register is set under the Create/Select Tool definition dialog.

Properties Feeds & Speeds
baterial | CARBIDE ~

Cut Matenial Color [ |*

MHurnber of Flutes

Al [ 4[|

T ool Murmber

4k

Adjust Reaister

Cutcom Hegister

Auial Offzet 0

LS

la one
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MILL Holder Worksheet
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8.2

Mill Tool Worksheets

The following Mill Tool Worksheets are available:

1. Ball Mill Worksheet
Flat Mill Worksheet

Corner Radius Mill Worksheet

Vee Mill Worksheet

Chamfer Mill Worksheet

Taper Mill Worksheet
Thread Mill Worksheet

© N o g ke DN

Dovetail Mill \WWorksheet

9. Fillet Mill Worksheet

10. Lollipop Mill Worksheet

11. User Defined Mill Worksheet

12. Drag Knife Worksheet
13. Saw Tool Worksheet
14. Laser Tool Worksheet
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Ball Mill Worksheet
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Flat Mill Worksheet

8.2.2
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8.2.3 Corner Radius Mill Worksheet
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8.24 Vee Mill Worksheet
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8.2.5 Chamfer Mill Worksheet
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8.2.6 Taper Mill Worksheet
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Thread Mill Worksheet

8.2.7

&4 woy peo

1 Ypda ]

o
4

[aAs Z Woyog

3

zaed 534

i
4

3

s[ana| uaawag abun4

@
4

$10)08 4 UDNanpay aE Y paad

: 125 () pidey asn ()
13JEUE |

- - -

- -

amnpeda] el JV=HE n7J

- - -
-

abebuy  yoeouddy abun|4

(L) seieY pes

M2 M2 uogaang

HdH = paads
slajaneE apuds

spaads g spaay  s=ampadoly

4

3

3

4

3

3

gLEBLILOT

fIVL=Tlalelg

13S0 Ry

1ajzifiay woagng

lepBay Enipy

Iaguiny oo |

8N4 JO Iqunpy

[ | iopgEuEEp g

[ELSiE

spaads i spaay  s=ipadoly

W peaJyl

~ 12pIoH

Y Y -

_._nqu_n__umu__._._. q.m._n___u_u._. i

- - -

Uz =h|4

usIEpnoyg  UEE0]  EIQjuRyS

AER

lalale|d ool

—

I

yifuEn
alni4

— Yild
Jﬂh peadyl

LiLET
Japinoys

_+

lajaLeln

1 UEUS

AGAANIEN LG

o
|

AR NEER

© 2026 MecSoft Corporation



Cutting Tools Workbook - RhinoCAM-MILL

Face Mill Worksheet

76
8.2.8
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Dovetail Mill Worksheet
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8.2.10 Fillet Mill Worksheet
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8.2.11 Lollipop Mill Worksheet
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8.2.12 User Defined Mill Worksheet
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8.2.14 Saw Tool Worksheet
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8.2.15 Laser Tool Worksheet
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8.3 Drill Tool Worksheets

The following Drill Tool Worksheets are available:
1. Drill Worksheet

Center Drill Mill Worksheet

Reamer Worksheet

Tap Worksheet

Bore Worksheet

2B

Reverse Bore Worksheet
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Drill Worksheet

8.3.1
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Center Drill Worksheet

8.3.2
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8.3.3 Reamer Worksheet
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8.3.4 Tap Worksheet
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Bore Worksheet

8.3.5
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8.3.6 Reverse Bore Worksheet
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84 Turn Tool Worksheets

The following TURN Tool Worksheets are available:
1.

© N o g ke DN

Diamond Insert Mill Worksheet

Triangular Insert Worksheet

Round Insert Worksheet

Trigon Insert Worksheet

Parallelogram Insert Worksheet

Groove Insert Worksheet

Thread Insert Worksheet

Part Off Insert Worksheet

91
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Diamond Insert Worksheet

8.41
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8.4.2 Triangular Insert Worksheet
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8.4.3 Round Insert Worksheet
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8.4.4 Trigon Insert Worksheet
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Parallelogram Insert Worksheet

8.4.5
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8.4.6 Groove Insert Worksheet
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Thread Insert Worksheet

8.4.7
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Part Off Insert Worksheet

8.4.8
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8.5 Feeds & Speeds Data
8.51 Feeds & Speeds Data (INCH)

For INCH units, the Surface Speed and Feed/Tooth provided in the Feeds & Speeds Calculator are
derived from the file FeedsSpeedsDatalNCH.xml. You can customize this file to add your own
materials.

This file is located at: C:\ProgramData\MecSoft Corporation\RhinoCAM for Rhino x.x\Materials

n CAUTION!! - Before editing this file - Make sure you create a copy of this file and

keep itin asafe place, outside of the install path of RhinoCAM. Also, make sure
you maintain the XML format of this file or the Feeds & Speeds Calculator may not
work properly.

Here is the tabulated format of the file. It will help you understand the XML files format for
recording data.

Stock Toolpath Tool Surface T
Material Type Material Speed i ]
ALUMINUM - 2024 MILLING | CARBIDE | 1600.00 0.0:040

MILLING H55 400.00 0.0040
MILLING | CERAMIC | 400.00 0.0040
DRILLING | CARBIDE | 960.00 0.0048
DRILLING H55 240.00 0.0048
DRILLING | CERAMIC | 240.00 0.0048
TURNING | CARBIDE | 1B00.00 0.0200
TURNING |CERAMIC | 1B00.00 0.0200
TURNING | CERMET | 1B00.00 0.0200
ALUMINUM - 5050 MILLING | CARBIDE | 1600.00 0.0040
MILLING H55 400.00 0.0040

T W N X TN e meyeenmpyyy — o

Below is an excerpt from the FeedsSpeedsDatalNCH.xmI XML file:

<Version>1.0</Version>

<Units>Imperial</Units>

<FeedsSpeeds>

<Material>
<Name>ALUMINUM - 2026</Name>
<TextureFile>ALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
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<FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>
</Material>
<Material>
<Name>ALUMINUM - 5050</Name>
<TextureFile>ALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00, 0.0200</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>
</Material>

8.5.2 Feeds & Speeds Data (METRIC)

For METRIC units, the Surface Speed and Feed/Tooth provided in the Feeds & Speeds Calculator
are derived from the file FeedsSpeedsDataMM.xml. You can customize this file to add your own
materials.

This file is located at: C:\ProgramData\MecSoft Corporation\RhinoCAM for Rhino x.x\Materials

n CAUTION!! - Before editing this file - Make sure you create a copy of this file and

keep itin asafe place, outside of the install path of RhinoCAM. Also, make sure
you maintain the XML format of this file or the Feeds & Speeds Calculator may not
work properly.

Here is the tabulated format of the file. It will help you understand the XML files format for
recording data.
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Stock Toolpath Tool Surface 1/ Tootl
Material Type Material Speed F
ALUMINUM - 2024 MILLING | CARBIDE 487 .68 0.1016

MILLING HSS 12192 0.1016
MILLING |CERAMIC | 121.92 0.1016
DRILLING | CARBIDE | 29261 0.1219
DRILLING HSS 73.15 0.1219
DRILLING | CERAMIC 73215 0.1215
TURNING | CARBIDE | 54B.e64 0.5080
TURNING |CERAMIC| 548564 0.5080
TURNING | CERMET | 548.64 0.5080
ALUMIBLIM - 5050 MILLING | CARBIDE | 4E7.68 0.1016

=y “‘a__

Below is an excerpt from the FeedsSpeedsDataMM.xml XML file:

<Version>1.0</Version>

<Units>Metric</Units>

<FeedsSpeeds>

<Material>
<Name>ALUMINUM - 2026</Name>
<TextureFile>SALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 487.68, 0.1016</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 121.92, 0.1016</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 121.92, 0.1016</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 292.61, 0.1219</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 73.15, 0.1219</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 73.15, 0.1219</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CARBIDE, 548.64, 0.5080</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERAMIC, 548.64, 0.5080</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERMET, 548.64, 0.5080</FeedsSpeedsRecord>

</Material>

<Material>
<Name>ALUMINUM - 5050</Name>
<TextureFile>ALUMINUM.bmp</TextureFile>
<FeedsSpeedsRecord>MILLING, CARBIDE, 487.68, 0.1016</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, HSS, 121.92, 0.1016</FeedsSpeedsRecord>
<FeedsSpeedsRecord>MILLING, CERAMIC, 121.92, 0.1016</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CARBIDE, 292.61, 0.1219</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, HSS, 73.15, 0.1219</FeedsSpeedsRecord>
<FeedsSpeedsRecord>DRILLING, CERAMIC, 73.15, 0.1219</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CARBIDE, 548.64, 0.5080</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERAMIC, 548.64, 0.5080</FeedsSpeedsRecord>
<FeedsSpeedsRecord>TURNING, CERMET, 548.64, 0.5080</FeedsSpeedsRecord>

</Material>

<Material>
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8.6 Default Tool Libraries
8.6.1 Default English Tools Library

The following table lists each tool included in the DefaultEnglishTools.csv library file.

This file is located at: C:\ProgramData\MecSoft Corporation\RhinoCAM for Rhino x.x\Data

© 2026 MecSoft Corporation
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8.6.2 Default Metric Tools Library
The following table lists each tool included in the DefaultMetricTools.csv library file.

This file is located at: C:\ProgramData\MecSoft Corporation\RhinoCAM for Rhino x.x\Data
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Where to go for more help

Download this PDF Guide for a list of the available RhinoCAM Resources.

[T] 2026 RhinoCAM Resource Guide

S Y The 2026 RhinoCAM Resource Guide!
RhinoCAM

Resource Guide |

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

— Prefer Printed Documentation? Check Here!

What's New | Quick Start Play List

© 2026 MecSoft Corporation
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https://mecsoft.com/WhatsNew/WhatsNewInRhinoCAM2026.pdf
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